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1 Enhancements
Description
The HP Insight Dynamics suite is advanced infrastructure management software that allows you to
analyze and optimize both physical and virtual resources in the same way. HP Insight Dynamics
gives you a powerful toolkit to accelerate complex technology projects and simplify daily operations.
It enables you to plan capacity and power continuously, provision infrastructure consistently, and
balance across physical and virtual resources. It also allows you to ensure cost-effective high
availability for a larger set of applications.
HP Insight Dynamics for ProLiant, HP Insight Dynamics for non-HP servers, and HP Insight Dynamics
- VSE for Integrity are integrated by design, delivering capabilities greater than the sum of its
parts. HP Insight Dynamics is based on proven HP technologies, such as HP Insight Control and
HP Systems Insight Manager (HP SIM), the world’s most popular platform management tool. HP
Insight Dynamics takes advantage of HP Virtual Connect to bring the flexibility of virtualization to
a physical environment.
•

HP Insight Dynamics for ProLiant and HP Insight Dynamics for non-HP servers include capacity
planning, advanced virtualization and logical server management, and Insight Orchestration
capabilities for automated design and provisioning.

•

HP Insight Dynamics for ProLiant also includes Insight Recovery for disaster recovery capabilities,
HP Insight Control for advanced power management, performance management, and server
deployment, and extends advanced virtualization management to HP server blades using HP
Virtual Connect technology.

•

HP Insight Dynamics - VSE for Integrity includes capacity planning, advanced virtualization
management, global workload management, and support for Integrity blades by HP Integrity
Virtual Machines, HP-UX Workload Manager, and Insight Remote support.

HP Insight Dynamics suite licenses
HP Insight Dynamics suite licenses are available for managing different types of systems, as shown
in the table below. The software is installed on a Central Management Server (CMS) running
Systems Insight Manager, which provides a browser-based user interface. A single CMS can be
used to manage different types of systems. The software is installed on the CMS once, regardless
of how many or what types of suite licenses are purchased.

Description
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Table 1 HP Insight Dynamics suite licenses
Suite license

Managed systems supported

CMS platform

• HP ProLiant servers running
Microsoft Windows or Linux

HP Insight Dynamics suite for ProLiant

HP Insight Dynamics suite for non-HP
servers

• HP BladeSystem c-Class ProLiant
server blades running Microsoft
Windows or Linux

• HP ProLiant server running Microsoft
• Virtual machines and VM hosts
Windows
running Microsoft Windows or
Linux running under VMware ESX, • HP BladeSystem c-Class ProLiant
server blade running Microsoft
VMware ESXi, or Microsoft
Windows
Hyper-V on HP ProLiant hosts
• Virtual machine running Microsoft
Windows running under VMware
• Virtual machines and VM hosts
ESX or Microsoft Hyper-V on HP
running Microsoft Windows or
ProLiant or selected non-HP host
Linux running under VMware ESX,
VMware ESXi, or Microsoft
Hyper-V on selected non-HP hosts
• Selected non-HP servers running
Microsoft Windows or Linux 1

HP Insight Dynamics - VSE suite for
Integrity

• HP Integrity servers running HP-UX, • HP ProLiant server running Microsoft
Windows
HP OpenVMS, Integrity Linux, or
Microsoft Windows for Integrity
• HP BladeSystem c-Class ProLiant
server blade running Microsoft
• HP Integrity server blades running
Windows
HP-UX, HP OpenVMS, Integrity
Linux, or Microsoft Windows for
• Microsoft Windows virtual machine
Integrity
running under VMware ESX or
Microsoft Hyper-V on HP ProLiant or
• nPartitions running HP-UX, Integrity
selected non-HP host
Linux, or Microsoft Windows for
Integrity
• HP Integrity server running HP-UX
• Virtual machines running under HP • HP Integrity server blade running
Integrity Virtual Machines
HP-UX
• Virtual partitions running under a • HP-UX virtual machine running under
vPars monitor
HP Integrity Virtual Machines

1

Provisioning of physical servers and automated power control is not supported for these servers; logical servers on
non-HP hardware is limited to virtual machines

IMPORTANT: This table is a summary. Specific supported hardware and software configurations
are provided in the HP Insight Software 6.2 Support Matrix, available at www.hp.com/go/
insightdynamics/docs.

New capabilities in HP Insight Dynamics 6.2 software
HP Insight Dynamics 6.2 software provides new capabilities and expanded platform support.
•

New hardware support
◦

Integrity BL8x0c i2 server blades and Superdome 2 server support
Systems Insight Manager discovery, power management, visualization, capacity planning
and workload management for BL860/70/90c i2 Integrity server blades

◦
•
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Fibre Channel over Ethernet (FCoE) via Virtual Connect FlexFabric (for ProLiant)

New hypervisor support
◦

VMware ESX 4.1 managed nodes

◦

VMware ESXi 4.1 managed nodes

Enhancements

•

HP Insight Orchestration (infrastructure orchestration) (Windows CMS only)
◦

VMware vNetwork Distributed Switch (vDS)

◦

SAN Virtualization Services Platform (SVSP) support for VMware and Hyper-V data stores

◦

Support for HP Integrity VM logical server operations

◦

VLAN tagging for Hyper-V

◦

Server Automation satellite support

◦

◦
•

◦

•

Single core server

–

Multiple boot networks (up to 255 IPs) may connect to a single core server

Service “host name customization"
–

Suffix pattern specification (printf)

–

No-suffix option for single-use templates

API/CLI enhancements

HP Insight Recovery (recovery management) (Windows CMS only)
◦

•

–

Microsoft Hyper-V virtual machines can be protected against disasters
–

Support for Microsoft Windows Server 2008 with Hyper-V R2 in a standalone
(non-clustered) configuration

–

Technology preview: Microsoft Windows Server 2008 with Hyper-V R2 in a clustered
configuration with cluster shared volumes (CSV)

Support for asynchronous mode in Continuous Access replication of EVA storage arrays

Capacity Advisor
◦

Models the memory for VMware ESX servers including only memory used by each VM,
as if the VM has no reserved memory (the current default setting for ESX). For HP Integrity
VM and Hyper-V, memory for VMs is still modeled as if all memory is reserved (an earlier
default setting for ESX)

◦

Peak Summary Reports are improved with new graphs

Logical server management (Windows CMS only)
◦

Cross-technology logical servers
Cross-technology logical servers, which can be moved between servers with Virtual
Connect and ESX virtual machines and between servers with Virtual Connect with unlike
configurations. Using Insight Recovery, the same type of movement can be accomplished
across sites and used for disaster recovery
Raw Device Mapping (RDM) for ESX virtual machine logical servers, which allows moves
between physical and virtual environments while still accessing the same boot and data
volumes

◦

HP Integrity VM logical servers
Logical server operations performed on HP Integrity VM guests on an HP-UX VM host,
using Shared Logical Volume Manager (SLVM) storage volumes or physical Fibre Channel
disks

◦

New storage pool entry types for integration with Storage Provisioning Manager catalog
entries, which support secure access to automated hostmode setting and masking
operations

◦

Virtual Local Area Network (VLAN)

◦

VMware vNetwork Distributed Switch (vDS)
New capabilities in HP Insight Dynamics 6.2 software
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◦

SAN Virtualization Services Platform (SVSP) support for VMware and Hyper-V data stores

◦

Integration with the mxsync backup and restore utility for automated and manual
post-restore recovery actions
For more information, see the Backing up and restoring HP Insight Software 6.2
Management Server (Windows) white paper at www.hp.com/go/insightdynamics/docs

•

Storage Provisioning Manager (SPM) (Windows CMS only)
HP Storage Provisioning Manager (SPM) is an optional tool for managing storage provisioning
within the Insight Dynamics software environment. It provides a secure service-centric
management interface to storage, allowing storage requests to be fulfilled with available
storage services from a storage catalog, and securely automating storage management tasks
by interfacing directly with storage arrays.
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2 Installation, configuration, and licensing
For system requirements and installation instructions on HP ProLiant and non-HP servers running
Microsoft Windows, see HP Insight Software 6.2 Installation and Configuration Guide.
For system requirements and installation instructions on a CMS running HP-UX, see HP Insight
Dynamics 6.2 Integrity CMS Installation and Configuration Guide.
These and other documents for HP Insight Dynamics software can be found at www.hp.com/go/
insightdynamics/docs.
See “Additional software dependencies” (page 12) for additional software not included with this
release that might be required in your configuration.

Newer version available for download
HP Insight Dynamics- VSE for Integrity
The latest version of HP Insight Dynamics - VSE for Integrity is available from the following location:
https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=vse

HP Insight Dynamics for ProLiant and non-HP servers
The latest version of HP Insight Dynamics for ProLiant and non-HP servers is available from the
following location:
https://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPID

Accessing online help before licenses are installed
You can access the HP Insight Dynamics online help before you have installed licenses on the CMS
by performing the following steps.
1.
2.

Select Help→For HP Systems Insight Manager from the top menu.
In your browser address bar (if enabled), change the URL from the first line to the second line:
https://{CMS-FQDN}:50000/mxhelp/mxportal/en/help-welcome.html
https://{CMS-FQDN}:50000/mxhelp/vsemgmt/en/licenses.html

3.

where {CMS-FQDN} is the fully qualified domain name of the CMS.
Press Enter to display the HP Insight Dynamics license management topic. From there, you
can select any of the help topics that apply to the entire HP Insight Dynamics suite. For help
specific to an individual component of HP Insight Dynamics, select the Related information
topic and choose one of the links in the section Help for related products.

Back up your existing CMS configuration before upgrading the software
HP recommends making a backup of your pre-6.2 environment before upgrading the software.
The upgrade process is not reversible. If, after you begin, you decide not to complete the upgrade
to HP Insight Software 6.2, a backup copy of your pre-6.2 environment is required to restore your
CMS to the pre-upgrade state.
See the HP Insight Software 6.2 Installation and Configuration Guide at www.hp.com/go/
insightdynamics/docs for detailed backup and restore instructions.

Newer version available for download
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IMPORTANT: After the upgrade process has successfully completed, you must also perform a
backup of the upgraded 6.2 configuration to restore your environment to a known good state in
the event of a catastrophic failure. This is necessary to ensure that managed resources, if they were
changed by the 6.2 CMS, will continue to be manageable if the CMS ever needs to be restored
from backup.
Refer to the Backing up and Restoring HP Insight Software Central Management System (Windows)
white paper at www.hp.com/go/insightsoftware/docs for instructions about backing up an HP
Insight Software DVD 6.2 Windows CMS.

Back up user-modified properties files before upgrade
During an upgrade, Insight Dynamics properties files from an earlier release are replaced by new
properties files for the 6.2 release. If you made any modifications or customizations to the properties
files, your changes are lost.
Suggested action
Before beginning an upgrade to Insight Dynamics 6.2, save a copy of user-modified properties
files or note any changes made to the files so that you can insert those modifications into the new
versions of the files.
Following is a partial list of properties files that are commonly modified. Verify in your environment
if you have modified these files before beginning an upgrade, and if you have modified them,
save the files to a location that is not under the \Program Files\HP\Virtual Server
Environment directory tree.
C:\Program
C:\Program
C:\Program
C:\Program
C:\Program
C:\Program
C:\Program
C:\Program

Files\HP\Insight
Files\HP\Virtual
Files\HP\Virtual
Files\HP\Virtual
Files\HP\Virtual
Files\HP\Virtual
Files\HP\Virtual
Files\HP\Virtual

Orchestration\conf\blade_models.properties
Server Environment\conf\esa.properties
Server Environment\conf\lsa\hp_lsa_service.conf
Server Environment\conf\lsa\lsa.properties
Server Environment\conf\lsa\lsaclient.properties
Server Environment\conf\lsa\vc\vcController.properties
Server Environment\conf\lsa\vmm\vmmController.properties
Server Environment\conf\lsa\storage\storageController.properties

After the upgrade has completed, but before the services are restarted or the CMS is rebooted,
edit the new properties files and add any custom entries made to the previous version of the file.

Clear browser cache after upgrade
After an upgrade to Insight Dynamics 6.2, or to a 6.2 update release, clear your browser's cache
before logging in to Insight Dynamics. In Internet Explorer, use Tools→Delete Browsing History. In
Firefox, use Tools→Clear Recent History.

User experience and application performance
HP Insight Dynamics is based on web client server technologies. Your perception of performance
can be affected by many external sources, including the central management server’s health,
network congestion and latency, and client side equipment and browser.
Every effort to balance performance and functionality has been made to the default settings to
create the best user experience under multiple browsers with different server environments. Changing
these default settings can result in adverse application responsiveness, which is more noticeable
in some browsers; for example, there are known memory issues in Internet Explorer 7 and 8 that
can be exposed in large scale environments. No matter which browser you choose to use, HP
recommends using the latest release and updates to improve your user experience and protect
your environment from the latest security threats.

Enabling template access restrictions in HP Insight Orchestration
Insight Orchestration supports template access restrictions on a per user basis. This feature is
disabled by default. If you do not modify the properties file, all users will see all templates.
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To enable template access restrictions, edit the file in the default location at C:\Program Files\
HP\Insight Orchestration\conf\hpio.properties, and set
template.access.restricted = true. After access restrictions are enabled, only users
assigned to a template will be able to see and use the template.

Switching between HP Server Automation cores
Insight Orchestration 6.3 supports SA 9.x by default. To revert to an earlier version of SA support
(for example, SA 7.83), perform the following steps to switch between SA cores.
1.

2.
3.

Replace opswclient.jar from the 9.x SA Core at C:\Program Files\HP\Systems
Insight Manager\lib with opswclient.jar from the SA Core to be configured with
installed Insight Dynamics. The location of opswclient.jar on the SA Core is /opt/
opsware/da/webapps/arm/WEB-INF/lib/opswclient.jar and /opt/opsware/
twist/extlib/client/opswclient.jar.
Remove the existing SA Core credentials and add the new SA Core credentials to the System
Insight Manager server using the mxnodesecurity utility.
Restart the HP System Insight Manager Windows service.

Operations Orchestration Studio installation and upgrade issues
Pointing a remote Operations Orchestration Studio installation to Operations
Orchestration Central installed on a CMS
A “Failed Login” error message is displayed when you try to log in to Operations Orchestration
Studio 7.51 pointing to a remote repository (for example, Operations Orchestration Central 7.51
on the CMS).
To resolve this issue, perform the following steps:
1.
2.

3.

Make a backup of the rc_keystore file on the CMS.
Copy the rc_keystore file installed on the CMS (C:\Program Files\HP\Operations
Orchestration\Central\conf\rc_keystore) to the same path on the remote
Operations Orchestration Studio system (C:\Program Files\HP\Operations
Orchestration\Studio\conf\rc_keystore).
Restart Operations Orchestration Studio.

Certificate key mismatch after Operations Orchestration Studio upgrade
After upgrading Operations Orchestration from version 7.51 to 9.0, Operations Orchestration
Central and Studio have different certificate keys. Operations Orchestration Studio cannot access
the URL https://localhost:16443.
To resolve this issue, perform the following steps:
1. Make a backup of the rc_keystore file on the CMS.
2. Copy the rc_keystore file installed on the CMS (C:\Program Files\HP\Operations
Orchestration\Central\conf\rc_keystore) to the same path on the Operations
Orchestration Studio system (C:\Program Files\HP\Operations Orchestration\
Studio\conf\rc_keystore).
3. Restart Operations Orchestration Studio.

Cannot download 64-bit Operations Orchestration Studio from Insight Orchestration
Designer
An icon in the Workflow dialog box in Insight Orchestration Designer allows you to download
and install the 32-bit version of Operations Orchestration Studio. If you download and attempt to
install the 32-bit version on a 64-bit CMS, the following error is displayed: “Studio version: 9.00
does not match Central version: 2.0. Setup will exit.”
Switching between HP Server Automation cores
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The 64-bit version of Operations Orchestration Studio is available on the Insight Software DVD
#2, in the /hpio folder.

Red Hat Enterprise Linux 5.5 cannot be installed in VM guest on ESXi 4.1
host on BL465c G7
Red Hat Enterprise Linux 5.5 cannot be installed in a VM guest on an ESXi 4.1 host on server
blade BL465c G7.
To resolve this issue, install RHEL 5.5 on the host system, install a RHEL 5.4 guest and then upgrade
the guest to RHEL 5.5, ensuring that kernel-2.6.18-194.3.1.el5 or higher is used.
For more information, see Red Hat’s Knowledgebase article at https://access.redhat.com/kb/
docs/DOC-38013.

Managing Microsoft Windows servers without OpenSSH installed
Even though the product documentation states OpenSSH is required, HP Insight Dynamics supports
Microsoft Windows environments not running OpenSSH. However, for Microsoft Windows systems
without OpenSSH, there are several limitations with agent installation and troubleshooting.
For details on using HP Insight Dynamics with Microsoft Windows systems not running OpenSSH,
see the HP Insight Dynamics 6.0 software without OpenSSH on HP ProLiant and Integrity Servers
Running Microsoft Windows white paper, available at the following website:
www.hp.com/go/insightdynamics/docs

Patch required for proper management of Microsoft Windows Server 2008
with Hyper-V systems
A patch from Microsoft is required for managing Microsoft Windows Server 2008 with Hyper-V
systems. Patches are installed on the Hyper-V hosts, and after you do so, you must install or update
Hyper-V Integration Services from the updated host to each VM guest. Do this as a precaution
because not all patches affect Integration Services on the guests.
Microsoft Windows Server 2008 SP2 with Hyper-V requires you to install the following patch that
fixes the hang in host servers with many simultaneous virtual machine operations. The patch is
located at http://support.microsoft.com/kb/980081.
See the Managing Microsoft Windows Server 2008 Hyper-V with HP Insight Software technology
brief for more information about other patches that might be required for later editions of Microsoft
Windows Server 2008 (R2):
http://www.hp.com/go/insightdynamics/docs

Managing a Microsoft Hyper-V (or any MSCS) cluster when an alias is
assigned by DHCP
In Windows Server 2008 Failover Clusters, if the cluster alias is assigned using DHCP, the cluster
alias PTR (reverse lookup) record in DNS will be incorrect, and will cause the cluster to be incorrectly
discovered in Systems Insight Manager.
To correct this problem, delete the cluster objects from Systems Insight Manager, take the steps in
the Microsoft Knowledge Base article at http://support.microsoft.com/kb/969049 to modify the
cluster DNS behavior, and then rediscover the cluster in Systems Insight Manager.

Additional software dependencies
The following are additional dependencies related to HP Insight Dynamics - VSE for Integrity
software.
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•

Instant Capacity Manager requires iCAP version 8.02 or higher installed on the HP-UX
managed systems.

•

HP Insight Dynamics - VSE for Integrity supports having multiple database instances hosted
by Microsoft SQL Server. Refer to the Microsoft SQL Server documentation for instructions on
how to set up a system to host multiple SQL Server database instances.

Additional software dependencies
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3 Issues and suggested actions
Issues and limitations of this release are listed below, organized by HP Insight Dynamics feature
or functional area. If a feature or functional area has no limitations or issues, that category will
not appear. The following categories are used:
Limitations

Limitations of the implemented feature or functional area.

Major issues

Issues that may significantly affect functionality and usability.

Minor issues

Issues that may be noticeable but do not have a significant impact on
functionality or usability.

HP Insight Dynamics software
Limitations
Configuring Insight Dynamics with a remote Microsoft SQL Server database
Because Windows Single Sign On is used by Insight Dynamics to connect to the SQL Server
database, the credentials associated with the user account executing a command or service are
used to connect to the remote database. Therefore, user accounts used to execute Insight Dynamics
software that accesses the database must satisfy the following conditions:
•

The user credentials specified for the CMS access and database access during the installation
should be the same, and be trusted domain credentials available to both the CMS and database
systems.

•

The user credentials specified during the installation for the database access should have
access permissions to the database.

If you run a CLI command as a user that is not a domain user or does not have database access
permission on the remote database, and the CLI command requires database access, the command
will fail.

Major issues
Unable to get detailed disk information on Microsoft Hyper-V VM host with a QLogic HBA
Because of an issue with the QLogic HBA driver, detailed disk information is unavailable for disks
visible to the QLogic HBA card to manage virtual machines on the VM host.
Without this driver, you cannot select SAN disks as storage when creating a virtual machine logical
server. This prevents you from moving the virtual machine within a Microsoft Hyper-V cluster.
Suggested action
Update the Windows driver of the QLogic HBA to 9.1.8.25 or higher.
To locate and download the driver, perform the following steps.
1.
2.
3.
4.
5.

Go to http://www.hp.com and click Support & Drivers at the top of the screen.
Select “Download drivers and software (and firmware)”.
Enter the product number for your product (for example, AE312A is the product number for
HP StorageWorks FC1242SR 4 Gb PCIe HBA).
Select the operating system you are running.
Download the “Storport Driver Component for QLogic FC HBAs and QLogic-based FC
Mezzanine HBAs” (9.1.8.25 or higher).

HP Insight Dynamics software
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Using a remote CMS database with components that use ESA for storage provisioning and server
operations
Some components in Insight Dynamics use the Extensible Server & Storage Adapter (ESA) for
storage provisioning and server operations. Information about resources managed by these
components may be unavailable or missing if you are using a remote CMS database. These
problems occur because ESA cannot access its database when the CMS is using a remote database.
If your CMS is running a remote database and you are using HP Insight Orchestration, HP Insight
Recovery, or logical server management to manage:
•

Storage Provisioning Manager catalog-based storage pool entries
Candidate volumes will not be visible in SPM so you cannot create a catalog-based storage
pool entry. In Insight Orchestration, there will be no storage available for use.

•

Operations Orchestration Workflow physical servers or non-HP servers
Portability groups containing Operations Orchestration Workflow (OOWF) physical servers
or non-HP servers will not be available for selection when you create a logical server or storage
pool entry. Insight Orchestration will not be able to perform operations that depend on these
types of servers.

•

Annotated servers with Virtual Connect using Operations Orchestration workflows
The annotation will be missing, so there will be no server resources with local disks.

Suggested action
Change the account under which the ESA service runs to an account that has access to the remote
database.
After installing and configuring the Insight Dynamics CMS to use a remote database:
1.
2.

Sign into the CMS as Administrator.
Enter the following command:
sc qc "HP Logical Server Automation" 2096
The output will contain a line similar to the following. The string displayed is the account name
that was configured.
SERVICE_START_NAME : string

3.

Enter the following command, replacing string with the string in the preceding output. Note
the space between obj= and string.
sc config esa obj= string

4.

Restart the ESA service using the Windows Services GUI, or by entering the following two
commands:
sc stop esa
sc start esa

Capacity Advisor
Limitations
Automatic power calibration of Integrity Linux systems running SUSE 11 operating system is not
supported
The HP Insight Dynamics 6.2 software does not support the automatic power calibration of Integrity
Linux systems running the SUSE 11 operating system.
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Suggested action
Manually calibrate Integrity Linux SUSE 11 systems for power.

Automatic power calibration requires power metering support in server
Auto-calibration of idle/max power with Capacity Advisor requires the power metering features
of iLO in the managed server. For information about which servers support power metering, see
Appendix A in the HP Insight Software 6.2 Support Matrix at www.hp.com/go/insightdynamics/
docs.
Suggested action
Manual power calibration is recommended for servers that do not support iLO power metering.

Sub-OS workloads on Linux systems are not supported
On x86 and Integrity Linux systems, Linux sub-OS workloads cannot be created or modeled, and
sub-OS workload data cannot be collected.
On Linux systems where the Utilization Provider was previously installed and sub-OS workloads
were defined, those sub-OS workloads will no longer be displayed in Virtualization Manager. The
definition of these sub-OS workloads on a Linux system will be removed from Virtualization Manager
by the upgrade process because they are no longer used by Insight Dynamics Global Workload
Manager (gWLM), nor supported by Capacity Advisor or Virtualization Manager.

Data collected for VMs or OS workloads that migrate across three or more dissimilar hosts in a
24-hour period may be marked invalid
Some historical performance data in Capacity Advisor will be marked as “invalid” (and will appear
to be missing in the Profile Viewer) when VMs or operating systems instances have migrated across
three or more VM hosts or servers with different clock speeds since the last Capacity Advisor data
collection. By default, invalid data is not included in Capacity Advisor calculations.
Suggested action
For planned migrations between dissimilar VM hosts or servers, always collect Capacity Advisor
data at least once between migrations to obtain a valid data sample for each configuration visited.
Alternatively, avoid frequent VM or OS migrations across three or more dissimilar hosts or servers.
If these actions are not possible (for example, for automatic migrations within clusters with dissimilar
hosts), you can validate any data that was invalidated as a result of multiple migrations, and use
it as an estimate of historical performance data, even though it may not be accurately normalized.
NOTE: For Integrity VMs, data must always be collected prior to a migration. Failure to do so
will result in either incorrect data or a gap in data that starts from the time that the last collection
occurred before the migration and ends at the time that the VM was migrated.
See the HP Insight Capacity Advisor 6.2 Software: User Guide at www.hp.com/go/
insightdynamics/docs for information about showing, and optionally validating, invalid data.

Minor issues
Socket and core count inaccurate on Microsoft Windows 2003 and HP-UX 11 v2 (IA and
PA) systems
Windows 2003 and HP-UX 11 v2 (IA and PA platforms) operating systems may not correctly report
the number of processor sockets in a multi-core/hyperthreading environment.
Suggested action
The following patches are required to correct this issue.
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•

For Windows 2003, apply the KB932370 patch. For more information, see http://
support.microsoft.com/kb/932370/.

•

For HP-UX 11 v2, apply the PHKL_37803 patch. You can download this patch from http://
www13.itrc.hp.com/service/patch/mainPage.do. After downloading, execute the command
sh PHKL_37803, and install the depot file that is generated.

No patch is necessary for Windows 2008 or HP-UX 11 v3.
This information does not apply to HP-UX 11 v1.

Global Workload Manager
Limitations
HP Integrity Superdome 2 support
The HP Global Workload Manager (gWLM) supports Fair Share Scheduler (FSS), Partition Sets
(PSETS), and HP Integrity Virtual Machines on HP Integrity Superdome 2. Global Workload Manager
does not support nPartitions and vPartitions. Online migration of CPU is also not supported.

HP Insight Orchestration
HP Insight Orchestration runs on an x86/x64 Windows CMS.

Limitations
Number of networks provisioned to a logical server
The Insight Dynamics infrastructure template Designer does not restrict the number of networks that
can be connected to a logical server group. In practice, only four networks can be connected to
virtual logical servers, and 32 networks can be connected to physical logical servers designed to
run on HP c-Class server blades. These practical limits will increase over time as Virtual Connect
and hypervisors are enhanced.
If these limits are exceeded in an infrastructure template, provisioning operations using that template
will fail.
Suggested action
Limit the number of network connections to a logical server group to four for virtual logical servers
and 32 for physical logical servers.

Manually configure the SAN boot path for ProLiant DL/ML servers before provisioning
The job "Deploy ProLiant System Configuration (BL BFS),” contained in the Insight Control Rapid
Deployment software job folder deployed using Insight Orchestration, cannot be used to configure
ProLiant DL/ML target servers. The job configures ProLiant/Integrity BL target servers. If you attempt
to configure ProLiant DL/ML servers using this job, the request will fail.
Suggested action
Manually configure the SAN boot path before you use Insight Orchestration to provision a ProLiant
DL/ML target server on SAN boot LUN, as follows.
1. Create a server deployment job folder that does not contain the "Deploy ProLiant System
Configuration (BL BFS)" job.
2. Change the Boot Controller Order (from ROM-Based Setup Utility) for the ProLiant DL/ML
server to select Fiber Channel port (HBA) as the first in the boot order.
3. Use the HBA vendor's utility to configure the HBA's boot path to boot from the desired SAN
boot LUN.
4. Power off the target server after the Boot Controller Order and the HBA's boot path have been
configured correctly.
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Manual OS or SA OS provisioning of virtual machines to a local disk on a VM host is not supported
HP Insight Orchestration supports “manual OS” or “SA OS” provisioning of virtual machines to
shared storage only. Provisioning using ESX or Insight Control virtual machine management
“template cloning” is supported for local disks on VM hosts.
Suggested action
Exclude local disks on VM hosts that will be used for “manual OS” or “SA OS” provisioning.
1.
2.
3.

Open the properties file in the default location at C:\Program Files\HP\Insight
Orchestration\conf\hpio.properties.
Modify the volume.exclusion.list property to exclude all local disks visible to all VM hosts.
Restart the HP Insight Orchestration service for the changes to take effect.

Required HBA firmware and OS drivers to access multi-initiator NPIV data disks
The HP blade multi-initiator NPIV feature allows you to configure multiple WWNs for a single HBA
connected with a Virtual Connect Fiber Channel module. Although Insight Dynamics automates
the configuration, certain versions of HBA firmware and drivers are required to access multi-initiator
NPIV data disks configured for any target BL server.
Suggested action
The HBA firmware and drivers shown for the following operating systems are required to support
multi-initiator NPIV data disks.
•

QLogic HBA (BIOS version 2.07 or higher)
RHEL 5.3 and higher
SLES 11 and higher
SLES 10 SP3 and higher
Windows 2003/2008: QLogic driver 9.1.7.29 or higher

•

Emulex HBA (BIOS version 3.11a3 or higher)
RHEL 5.4 or higher
SLES 10 SP3 or higher
SLES 11 in-box driver not yet available. Requires out-of-box Emulex driver version: 8.2.8.32
Windows 2003/2008: Emulex driver 5.00.17.06-2 or higher

Multi-initiator N-Port ID Virtualization (NPIV) features on Integrity blades are not supported
Multi-initiator NPIV features used by Insight Dynamics and Virtual Connect Enterprise Manager
are not supported on Integrity blades.
Suggested action
Create a single storage pool entry that combines a boot volume and the data volumes intended
to be allocated to a single physical server. You can do this in one of the following ways:
•

Pre-provision any number of these composite storage pool entries to enable fully automated
allocation of SAN volumes to physical servers.

•

Pre-provision storage pool entries with only boot volumes. An automated provisioning request
pauses after the operating system is deployed if the infrastructure service template specifies
data disks. You can modify the storage pool entry allocated to the server to add data volumes,
and then continue the request.

Install Microsoft Sysprep tool for customization of Windows 2003 guests on Hyper-V after installation
The Microsoft System Preparation (Sysprep) tool, which is required for customization of Windows
2003 guests on Microsoft Hyper-V, is not retained on the CMS after upgrading from previous
versions of Insight Software. Without these tools, customization of Windows 2003 guests on
Hyper-V results in failures.
HP Insight Orchestration
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Suggested action
To enable customization of Windows 2003 guests on Hyper-V, install the Microsoft Sysprep tool
on the CMS in the folder C:\Program Files\HP\Insight Control virtual machine
management\Sysprep\2003 after the installation or upgrade of Insight Software 6.2.

Cannot power on a virtual server during provisioning if VM hardware version is 4 and a template
contains more than three NICs
A request to power on an ESX virtual server may fail if the ESX VM hardware version is set to 4
and the virtual machine contains more than three NICs. Insight Orchestration provisions virtual
machines using ESX hardware version 4 by default, which allows a maximum of five PCI Controller
devices (two SCSI controllers and three NICs) attached to a virtual machine. ESX hardware version
7 allows four SCSI controllers and ten NICs.
Suggested action
Use an ESX native template with a hardware version of 7, or reduce the number of NICs in the
Insight Orchestration template to three or fewer.

Cannot retrieve software inventory from an SA 9.02 deployment server
Insight Orchestration ships with out-of-box support for Software Automation 7.83. You cannot
retrieve software inventory from an SA 9.02 deployment server.
Suggested action
Manually enable support for SA 9.02.
1.
2.
3.
4.

Stop the HP System Insight Manager windows service
Copy opswclient.jar from the 9.02 SA Core at /opt/opsware/twist/extlib/
client/opswclient.jar to CMS:<SIM>\lib
Copy SAplugin.jar from CMS:<IO>\update\6.2.1\SA9.x_support\SAplugin.jar
to CMS:<SIM>\lib
Start the HP System Insight Manager windows service

Console access to provisioned virtual servers from operating systems and browsers
Launching a console to a provisioned virtual server (VM) hosted on VMware ESX 3.5, ESX 4, ESXi
3.5, and ESXi 4 VM hosts is supported using Microsoft Internet Explorer and Mozilla Firefox
browsers running on Windows XP and Windows 2003 operating systems.

Browsing to user interface requires default Systems Insight Manager port
HP Systems Insight Manager is installed with a default port of 50000 in the JBoss container.
Browsing to the Insight Orchestration user interfaces, for example, Designer, depends on this port
value.
Suggested action
Do not modify the Systems Insight Manager default port of 50000 in the JBoss container.
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Erase Hardware job name and service name of a provisioning task must not contain non-English
characters
The following issues may occur if your browser language is set to Japanese.
•

If you are using HP Insight Control server deployment on Japanese operating systems and you
specify a Japanese job name for the Erase ProLiant Hardware job, the service is not removed
after physical provisioning.

•

If you specify Japanese characters for the service name of a provisioning task, the logical
server is not provisioned.

•

If you create a new virtual provisioning template and configure mail settings, the “Approve
or Reject” e-mail contains a garbled service name.

Suggested action 1
1.
2.
3.

Launch the Deployment Console.
Rename the Erase ProLiant Hardware job to a name that does not contain non-English
characters.
Retry the operation.

Suggested action 2
Specify a service name containing valid characters ([a-z] [A-Z] [0-9] [_] [-] [space]).
Suggested action 3
Use the Insight Orchestration Operations Console to approve or reject requests that contain Japanese
characters.

Major issues
Using a remote CMS database with components that use ESA for storage provisioning and server
operations
See “Using a remote CMS database with components that use ESA for storage provisioning and
server operations ” (page 16) for information about an issue that may affect HP Insight Orchestration.

Minor issues
Deployment to a Hyper-V cluster server volume may fail unless the template resides in the
Hyper-V cluster
An HP Insight Orchestration virtual machine deployment to a Hyper-V cluster server volume may
fail when it has reached approximately 60 percent of completion if the source server where the
template resides is not in the Hyper-V cluster. The following error is displayed:
Error deploying Logical Server logical-server-name. Failed to copy all the disk files from source to target
Server. Check the availability of disk space on the target.

Suggested action
Ensure that the source server that contains the template is stored in the Hyper-V cluster before
starting the VM deployment.

Delete service request leaves "clean-me" logical servers when used with Integrity servers
After successfully provisioning an Integrity blade using Ignite-UX, there are manual steps you must
perform to allow the disk to be erased during de-provisioning. Erasing the disk is part of a successful
de-provisioning (delete request) for an Integrity service.
If the disk is not erased, the delete service request may fail and “clean me” logical servers will
remain. In that case, a manual clean-up procedure is required. (See the Suggested action for the
clean-up procedure.)
Before you start a delete request from Insight Orchestration:
HP Insight Orchestration
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1.
2.

Make sure that the Integrity service was successfully provisioned (the Integrity service is running).
Discover the Integrity blade where the Integrity service is running using its IP address from
Systems Insight Manager. The Integrity node's identification information should contain the
UUID and UUID (logical). You can discover the blade in either of the following ways:
a. Use the Systems Insight Manager menu selection Options→Discovery..., or
b. Use the Systems Insight Manager command: mxnode -a <ip-address> -w
where <ip-address> is the IP address that was assigned to the Integrity blade after
provisioning.
Add the root login of the Integrity blade using the Systems Insight Manager menu selection
Options→Security→Credentials→ Credentials....

3.

To set up an SSH connection between the CMS and the Integrity blade, enter the command:
mxagentconfig -a -n <ip-address> -u <username> -p <root password>

Suggested action
If you did not perform the preceding steps before you started a delete request for the Integrity
service, the automatic delete service will not succeed completely. In that case, you must clean up
the logical server associated with the Integrity blade and manually erase the disk.
1.
2.
3.

Power on the server blade. (The blade was powered off when delete service completed or
failed.)
Perform steps 2 and 3 above, if you did not do so before starting the delete request.
To erase the disk, enter the following command from the CMS:
mxexec -t "Ignite Erase Disks" -n <ip-address>

Customizations to the blade_models.properties file are not saved after upgrade
During an upgrade, the blade_models.properties file from an earlier release is replaced
by a new file for the 6.2 release. If you made any modifications or customizations to the
blade_models.properties file, your changes are lost.
The blade_models.properties file is used to declare any new server models to be managed
in Insight Orchestration. For example, if you modified this file to add rack mount server models so
that physical provisioning can be performed using ESA, you will no longer be able to provision
to those systems after an upgrade.
Suggested action
Before an upgrade to Insight Dynamics 6.2, save a copy of the C:\Program Files\HP\Insight
Orchestration\conf\blade_models.properties file to a location that is not under the
\Program Files\HP\Insight Orchestration or \Program Files\HP\Virtual
Server Environment directory trees, or note any changes made to the file. After the upgrade,
edit the new blade_models.properties file to add back in any custom entries made to the
previous version’s file.

Clear browser cache after upgrade
After an upgrade to Insight Dynamics 6.2, or to a 6.2 update release, if your web browser cache
has not been cleared you may not be able to log into Insight Orchestration.
Suggested action
Clear your browser's cache (history) before launching Insight Orchestration after an upgrade.

Virtual machine deployment on Microsoft Hyper-V with High Availability does not create
an HA VM
If an Insight Orchestration template is configured to manually deploy a Hyper-V virtual machine
or use SA jobs to deploy a non-linked clone Hyper-V virtual machine with High Availability (HA)
selected, the provisioning operation completes and reports success. However, the virtual machine
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is not created as a service on a Windows failover cluster configuration, which means that the
virtual machine is not an HA virtual machine.
This issue occurs only if “Manual software deployment” is selected on the Software tab of the Edit
Server Group Configuration dialog in the Insight Orchestration template.
Suggested action
After the virtual machine is deployed by Insight Orchestration, manually configure the virtual
machine as a cluster service.
1.
2.
3.
4.
5.
6.
7.

Access the Microsoft Hyper-V Failover Cluster Manager.
In the left menu under the “Failover Cluster Manager” tree, select “Services and applications.”
From the top Action menu, select “Configure a Service or Application.”
Navigate to “Select Service or Application.”
Select the “Virtual Machine” service and click Next.
Select the desired Virtual Machine from the list and click Next.
Follow the remaining steps on the screen to configure the virtual machine as a cluster service
until the “Summary” is presented.

Console and Self-Service Portal do not reload logical server group software details and
network resource details after selecting another template
If you view the Software Details tab for logical server groups, or the Resource Details tab for
networks in a template in the Insight Orchestration Console or Self-Service Portal, then select another
template and reselect the original template, the logical server group Software Details or network
Resource Details tab for the original template provides incorrect information.
Suggested action
To repopulate the logical server group Software Details or network Resource Details tabs, reload
the browser and select the original template.

Launching Telnet connection causes navigation error in IE 7 and IE 8
If you attempt to launch a Telnet connection to a deployed server from the Insight Orchestration
user interface, Internet Explorer opens a popup window that asks if you want to view only the
content that is delivered securely. If you click “Yes”, a navigation error page is displayed.
This issue occurs in Internet Explorer 7 and 8 only.
Suggested action
Click “No” in the popup window to launch Telnet.

Access error on Insight Orchestration web pages from e-mail notification using private
network
In some cases, the administrator cannot access the approve/reject web page (and other HP Insight
Orchestration pages) from the notification e-mail that asks the administrator to continue or reject
a user request. An access page error appears instead of the expected Insight Orchestration request
web page.
This error occurs when the HP Insight Orchestration CMS is configured to use a private network,
and the private network communicates with a public network. The private network is only accessible
from the HP Insight Orchestration CMS, and it is used to provision virtual and physical infrastructures.
Insight Orchestration notification e-mail is set with the private network settings which does not allow
external access to the URLs contained in the notification e-mail.
Suggested action
To allow access to Insight Orchestration web pages in e-mail from the private or public network:
1.
2.

Open HP Operations Orchestration Studio and log in using valid credentials.
Expand the Configuration node.
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3.
4.
5.
6.
7.

Expand the System Properties node.
Double click the HpioCmsIp property.
Click the Lock button to check out the property.
Update the property value to the hostname of the CMS.
Click Save and Check in.

Console "Authorization failed" error requires latest Adobe Flash Player
In a browser running Adobe Flash Player 10.0.22.87 or earlier, the Insight Orchestration console
may display the following error:
The Insight Orchestration tool cannot be displayed.
Problem:
Authorization failed for user dr7he05qdxix.

Suggested action
Upgrade to the latest Adobe Flash Player, available at http://get.adobe.com/flashplayer. Then
restart the browser, and browse to Systems Insight Manager and the Insight Orchestration console.

ioexec virtual machine provisioning fails during service creation when host name and
service name exceed character limits
If you use the ioexec command to create a new service, virtual machine provisioning failures can
occur if the server host name exceeds 13 characters, or the service name exceeds 16 characters.

Server in Insight Orchestration Server Pools remains in the server pool after removal from
enclosure
A removed server blade may remain in the Insight Orchestration Server Pools and Servers list, even
after removal from the blade enclosure and from VSE Resources. You can apply the server to a
new pool, but it will not be assigned to a service as the node will be tagged as an invalid target.
Suggested action
Remove the server from the pool before removing it from the blade enclosure. If you do not remove
the server from the pool first, the assignment of a new service will fail if there are no other targets
available in the pool.

Inconsistent state during CMS crash recovery of Add Disk operation
If the Insight Dynamics CMS crashes during an Add Disk operation of a physical disk, the status
of the request is incorrectly displayed as Completed, and the logical server may remain inactive
when the request is resumed and completes successfully. In addition, after crash recovery, running
virtual services are shown with the status Off.
Suggested action 1
Activate the logical server using Insight Orchestration.
Suggested action 2
Restart the HP Insight Orchestration service. This resets the status of the virtual services to Up.

Network inventory is not correctly reported when only vDS virtual switches are used
If an ESX data center is configured to use only vDS virtual switches, Insight Orchestration is not
able to correctly report network inventory for the data center.
Suggested action
Configure at least one non-vDS virtual switch on each of the ESX hosts in the data center.
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Database synchronization error in logical server deployment with automatically allocated
IP addresses
When deploying a logical server with automatically allocated IP addresses, an occasional failure
occurs due to a database synchronization error. The error displayed is similar to the following:
“A general error occurred during reservation. To resolve this issue, make sure all resources are
available: ask the Administrator to refresh Logical Server resources in Virtualization Manager and
refresh HP IO resources in the HP IO console. Once all resources are available, submit this HP IO
template again. If this error persists, contact the System Administrator."
Suggested action
Resubmit the create (or add server) request.

Rack mount servers left in power-on state following service delete
If you use Insight Orchestration to provision rack mount servers, the servers will be left in a power-on
state following service delete.
Suggested action
1.
2.

Edit the properties file in the default location at C:\Program Files\HP\Insight
Orchestration\conf\hpio.properties.
Change:
# Indicates if power state is preserved on physical provisioning failure
power.preserve.onfailure = true

to
# Indicates if power state is preserved on physical provisioning failure
power.preserve.onfailure = false

3.

Restart the HP Insight Orchestration Windows service.

Provisioning a non-VC physical server fails with "No MAC address was found" error when
incorrect server is allocated
During provisioning of a non-Virtual Connect physical server in an environment with multiple such
servers connected to disparate sets of networks, Insight Control server deployment completes the
operating system installation, but Insight Orchestration customization fails with the error
“CreatePhysicalServer completed with a failure status. No MAC address was found for network
network–name in HP Logical Service Automation (LSA) service.” The server selected for provisioning
is not connected to the network-name in the error message.
Suggested action
Organize non-VC physical servers into Insight Orchestration server pools according to their network
connectivity. Specify the appropriate server pool(s) for each Create Service request.

HP Insight Rapid Deployment software name changed to HP Insight Control server
deployment
HP Insight Control server deployment was previously known as HP Insight Rapid Deployment
software and was also referred to by the acronym RDP. Both previous names appear in the Insight
Orchestration application and associated help topics. These old names will be replaced in future
versions.
Suggested action
Note the name change when using the Insight Orchestration application and associated help
topics.

HP Storage Provisioning Manager
HP Storage Provisioning Manager runs on an x86/x64 Windows CMS.
HP Storage Provisioning Manager
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Limitations
Proper SAN ID specification when using an HP Operations Orchestration storage workflow for an
XP array
Unlike EVA arrays, XP arrays allow for target ports to be mapped individually to a LUN. This
mapping is performed at volume creation time (using the XP array device manager). For SPM to
be able to appropriately fulfill service requests from Insight Dynamics, it is critical to create SAN
IDs in SPM that correctly reflect how target ports are actually connected to the fabric, taking switch
zoning into account. Failure to do so can cause SPM to offer inadequate candidate storage services
back to Insight Dynamics. For example, SPM might present a storage service candidate to Insight
Dynamics that is not visible by the initiator(s) specified in the service request.
Suggested action
During storage volume allocation (using the XP array device manager UI), take note of how device
ports are mapped to volumes. Then, after the array is added to the SPM catalog, perform the
following steps:
1. From the SPM “Catalog” view (accessed by clicking on Catalog in the left-hand navigation
tree), use the “Define SAN IDs” button at the bottom of the screen and create a SAN ID for
each SAN to which the array is connected via one or more ports. (This feature can also be
accessed using the Catalog menu, in the “Define SAN IDs” selection.)
2. In the SPM "Array Properties" dialog, "Connectivity" tab: set the "SAN/Network Connectivity"
property for every target port in the array, using the SAN IDs created in Step 1.

Insight Managed System Setup Wizard
Limitations
Privilege elevation configuration that requires a password by the privilege elevation tool is not
supported
Insight managed system setup wizard supports privilege elevation only on a CMS that has privilege
elevation configured so that no password is required by the privilege elevation tool (such as su
and sudo). If you attempt to configure features when privilege elevation is turned on and requires
a password, you may see failures in the wizard's execution output.
Suggested action
If a feature fails to configure correctly because of privilege elevation password requirements,
configure the feature outside of the managed system setup wizard.
To turn off the requirement for a password, use the Systems Insight Manager
Options→Security→Privilege Elevation menu, and uncheck the check box labeled “A password
is required for this privilege elevation tool.” Note that systems managed by the CMS must be
reconfigured to reflect this configuration change.

Patch required to register HP Integrity VM hosts running Integrity VM 4.1 or higher and 11.31
HA-OE or DC-OE
The Insight managed system setup wizard fails to register HP Integrity VM hosts running Integrity
VM 4.1 or higher and either the 11.31 High Availability Operating Environment (HA-OE) or the
11.31 Data Center Operating Environment (DC-OE).
Suggested action
Apply the patch PHSS_40784 to the HP-UX 11i v3 Integrity VM host. The patch is needed on
systems where Serviceguard is installed, but the systems are not actively in a Serviceguard cluster.
Serviceguard is included with the HP-UX 11i v3 HA-OE and DC-OE.
You can download this patch from http://www13.itrc.hp.com/service/patch/mainPage.do. Select
Search by Patch IDs in the drop-down menu, then type PHSS_40784 in the search box.
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HP Integrated Lights-Out 3 (iLO3) support
HP Integrated Lights-Out 3 (iLO3) is supported in the current release of Insight managed system
setup wizard. However, iLO3 for ProLiant requires firmware version 1.05.
Suggested action
Update iLO3 ProLiant firmware to version 1.05.

HP Integrity rx2620 is not supported
In this release, using the Insight managed system setup wizard to configure an HP Integrity rx2620
server is not supported.
Suggested action
Manually configure HP Integrity rx2620 servers.

Minor issues
Insight managed system setup wizard fails to install the version 4.2 HP Integrity VM provider
on VM guest systems
The Insight managed system setup wizard attempts to install the version 4.2 HP Integrity VM provider
on VM guest systems running on an HP Integrity VM host whose version is greater than 4.2. When
the VM provider version on a VM guest is lower than the HP Integrity VM version on the host, the
managed system setup wizard will try to update the VM provider on the VM guest.
There are two scenarios in which the VM provider will fail to install on the VM guest:
•

If the Integrity VM version on the VM host is manually updated with a version greater than
4.2 and the VM provider on the VM guest stays at version 4.2 or earlier, the managed system
setup wizard will try to update the VM provider on the VM guest with the 4.2 version. This
does not cause any failures other than the managed system setup wizard attempting to install
the VM provider each time you try to configure Insight Dynamics features on that VM guest
system.

•

If the Integrity VM version on the VM host is manually updated with a version greater than
4.2 (for example, 4.4) and the VM provider on the VM guest is also updated with a version
greater than 4.2 (for example, 4.3) but less than the version of the Integrity VM host, then the
managed system setup wizard will try to install the VM provider version 4.2 on the VM guest.
The install will fail because there is a higher version of the VM provider already installed and
running on the VM guest. This failure can be safely ignored.

Suggested action
Manually update the VM provider on the VM guest system to match the Integrity VM version on
the VM host. After this is done, the managed system setup wizard will not attempt to install the VM
provider on the VM guest again.

Instant Capacity Manager
Limitations
Commands executed under privilege elevation may cause Instant Capacity Manager to monitor
but not control managed nodes
Some HP-UX security settings cause output to be generated every time a user is logged in. This can
occur, for example when sudo is used in Systems Insight Manager privilege elevation mode to
execute commands on HP-UX managed nodes, which can generate apparently extraneous output
to stderr. This output may be interpreted by some Instant Capacity (iCAP) Manager functions
executed under privilege elevation as error output from those commands.
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When this apparent error output occurs, the affected iCAP Manager functions fail. In this condition,
iCAP Manager can be used only to monitor, and not control, managed nodes configured in this
way.
Suggested action
Configure HP-UX managed nodes so that no extraneous output is generated when the sudo
command is executed.
For more information, see the following HP-UX documentation:
•

HP-UX 11i Security Containment Administrator’s Guide

•

HP-UX System Administrator's Guide: Configuration Management (HP-UX 11i v3)

•

HP-UX Servers and Workstations – HP-UX Standard Mode Security Extensions (HP-UX 11i v2)

•

the manpage man 4 security (particularly the discussion of DISPLAY_LAST_LOGIN)

Logical Server Management
Logical server management runs on an x86/x64 Windows CMS.

Limitations
Cross-technology logical servers
Following are limitations in cross-technology logical servers. Cross-technology logical servers can
be moved between servers with Virtual Connect and ESX virtual machines, and between servers
with Virtual Connect with unlike configurations.
•

Valid targets for activating or moving a cross-technology logical server:
◦

ESX Hosts: 3.5, 3.5i, 4.0, 4.0i, 4.1, and 4.1i

◦

ProLiant c-Class servers with Virtual Connect
Not supported: Servers with Virtual Connect with FCoE (Fibre Channel over Ethernet)
ports

•

Storage requirements:
◦

SAN volume presented to an ESX VM host (RDM disk) that can be added to a Virtual
Connect profile

◦

Data store shared on a SAN or iSCSI volume (to store the VMM configuration file and
RDM mapping file [.vmdk] on the ESX VM Host)
Not supported: SPM (catalog) storage volumes
In this release, catalog storage pool entries are supported on servers with Virtual Connect
logical servers only. Catalog storage pool entries cannot be used with cross-technology
logical servers that may be activated on an ESX VM Host

•

Network requirements:
◦

Single or multiple networks (limited to 4 by ESX)
Not supported: VLAN networks

Performing operations on a logical server running as a VM host
HP Insight Dynamics supports a logical server that is a physical server blade running a VM host.
Insight Dynamics also supports logical servers that are guest VMs on that physical server. In order
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to protect the VM guests from inadvertent operations, a logical server that is a physical server
running as a VM host has the following restrictions:
•

Deactivate, move, power off, and delete operations on the VM host logical server are not
supported while there are guest VM logical servers residing on the VM host logical server.
You must move the guest VM logical servers off of the VM host logical server before performing
any of these operations on the VM host logical server.

•

Deactivate, move, power off, and delete operations on the VM host logical server are not
supported while there are running jobs on the VM host logical server that could result in
creating or leaving a VM guest logical server on the VM host logical server. If this occurs,
re-identify the source and target server blades and VM host. If the orphan VM guest logical
server remains after re-identification, unmanage the logical server and, if necessary, remove
its underlying resources.

Managing a CMS as a logical server is not supported
HP strongly recommends that systems running Central Management Server (CMS) software not be
managed as logical servers. This includes the Insight Dynamics CMS, as well as any other CMS
managed by the Insight Dynamics CMS.
Note that logical server management does not prevent you from managing a CMS as a logical
server. For example, Insight Dynamics will allow any managed node, including the CMS, to be
selected for moving or other logical server operations; doing so may result in unpredictable results.

Hyper-V cluster shared volume created with GPT disk partitioning system is not supported
If you attempt to move a Hyper-V virtual machine logical server to a Hyper-V VM host that is
configured with cluster shared volume (CSV) storage with a GUID partition table (GPT) disk
partitioning system, the target host is rejected with the error:
VM Host was filtered out because the data storage of logical server
logical-server-name does not match the available storage on VM Host hyper-v-vm-host-name.

Suggested action
Recreate the CSV using master boot record (MBR) storage. GPT disks are typically used only if you
need volumes that exceed 2TB.

Moving a logical server from a Microsoft Hyper-V R2 host to a Hyper-V R1 host is not supported
A limitation from Microsoft prevents you from moving or reactivating a virtual machine logical
server from a Microsoft Hyper-V R2 host to a Hyper-V R1 host. An error message is displayed if
you attempt the operation.
You can move or reactivate a virtual machine logical server from a Hyper-V R1 host to a Hyper-V
R2 host.
NOTE: The Hyper-V host version is shown in the Platform column in the Available Target Hosts
table on the activate or move logical server target screen. The host is a Hyper-V R1 host if the host
version begins with 6.0 (for example, 6.0.6001 or 6.0.6002 in Windows 2008 Server – Hyper-V
SP1 or Windows 2008 Server – Hyper-V SP2). The host is a Hyper-V R2 host if the host version
begins 6.1 (for example, 6.1.7077 in Windows Server 2008 R2).
Suggested action
Be certain that you want to move or reactivate the logical server from Microsoft Hyper-V R1 to R2
before you complete the operation. After the operation completes, you cannot move or reactivate
the logical server back to Hyper-V R1.
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Importing a Microsoft Hyper-V virtual machine with configuration file in default location is not
supported
A Hyper-V virtual machine whose configuration file is in the default location on the hard disk in
\ProgramData\Microsoft\Windows\Hyper-V is not supported by logical server management.
You cannot import a virtual machine guest as a logical server if the virtual machine's configuration
file is in this location. There is a limitation in Microsoft Hyper-V that allows HP Insight Control virtual
machine management to re-register the virtual machine if the configuration file is created in this
directory. To prevent issues with reactivation, logical server management checks the path and
rejects any virtual machines with a configuration file in the default location.

iSCSI disk requirements for use with Microsoft Hyper-V virtual machine logical servers
To enable selection of a specific iSCSI data store as the storage definition during logical server
creation or modification, iSCSI disks associated with Microsoft Hyper-V hosts must be a cluster
disk or a shared cluster volume, online, and contain a volume created with a drive letter.

Microsoft Hyper-V virtual machine logical server boot disk is IDE and data disks are SCSI
When you create a Hyper-V virtual machine logical server, the boot disk (where Windows or Linux
is installed) is always created using an IDE controller. Data disks are created using a SCSI controller.
The IDE controller is required to allow the installation of the operating system using Deploy Tools
or using images without additional drivers.
If a virtual machine is created outside of Virtualization Manager and imported as a logical server,
it is possible that the boot disk controller type is SCSI. In this case, you must install the SCSI controller
driver to allow installation of the operating system.
If a virtual machine is provisioned by Insight Orchestration (using either a SCSI or an IDE controller)
and the logical server is imported, the virtual machine has an operating system installed so the
SCSI driver is not needed. If the boot disk controller type is SCSI, it is not changed.

One Microsoft Hyper-V target displayed when activating a logical server created on a cluster disk
volume
A limitation in Microsoft Hyper-V R1 prevents the hypervisor from providing logical server
management with required information about a Hyper-V cluster. The result is that only one target
is shown when you attempt to activate a virtual machine logical server configured to be created
on a cluster disk volume. In Hyper-V R1, a logical server that is high availability (HA)-enabled can
be configured only on a cluster disk volume.
Suggested action
Upgrade to Hyper-V R2. In R2, Microsoft corrected the problem so that the activation of a virtual
machine logical server configured to be created on a cluster disk or a cluster shared volume lists
all Hyper-V hosts in the cluster on the target screen.

File-based storage pool entry not supported
Beginning in HP Insight Dynamics 6.0 Update 1, file-based storage pool entries are not supported.
Storage pool entries must be RDM or SAN-based.
File-based storage entries are created by default for all virtual machine logical servers. However,
these entries cannot be inserted into the storage pool or managed on the Modify→Logical Servers
Storage Pools... screen.

Integrity VM logical servers with file-based storage and Windows or Linux guests are not supported
In this release, you can create an Integrity VM virtual machine logical server if you specify
Accelerated Virtual I/O Storage with virtual disk-backed storage only. All virtual disks will be a
logical volume created in a Shared Logical Volume (SLVM) Volume Group. You must create and
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add SLVM VGs to the storage pool on the VM Host for the CreateVirtual Disk operation to run
successfully. Local storage is not supported for Integrity VM virtual machines.
In addition, the Integrity VM virtual machine guest must have an HP-UX operating system type.
Windows and Linux guests are not supported.
Logical servers upgraded from Insight Dynamics 6.0 and 6.1, which allowed physical SAN disk
storage and Windows or Linux guest operating system types for Integrity VM logical servers, will
have limited features; for example, they can be moved and powered on and off.

Reactivating and moving logical servers created on ESX 4x VM Hosts to ESX 3x VM Hosts
The ESX 4 virtual hardware version prevents virtual machine logical servers that were first activated
on an ESX 4x VM host from being moved or reactivated on an ESX 3x VM host.
ESX 4x supports virtual hardware version 4 and version 7 VM guests, but ESX 3x supports only
version 4 VM guests.
You can successfully move a virtual machine logical server first activated on ESX 3x to an ESX 4x
VM host. If you attempt to move a logical server first activated on ESX 4.x to an ESX 3.x VM host,
logical server management checks the version and rejects the targets correctly.

Multi-initiator N-Port ID Virtualization (NPIV) features on Integrity blades running HP-UX and HP
OpenVMS
See “Multi-initiator N-Port ID Virtualization (NPIV) features on Integrity blades are not supported”
(page 19) for a limitation on defining storage pool entries.

Major issues
Unable to get detailed disk information on Microsoft Hyper-V VM host with a QLogic HBA
See “Unable to get detailed disk information on Microsoft Hyper-V VM host with a QLogic HBA”
(page 15) for information about downloading the QLogic HBA driver for Windows. Without this
driver, logical server management fails to operate correctly on Hyper-V cluster shared volumes
and cluster volumes with a QLogic driver.

Using a remote CMS database with components that use ESA for storage provisioning and server
operations
See “Using a remote CMS database with components that use ESA for storage provisioning and
server operations ” (page 16) for information about an issue that may affect logical server
operations.

LSA service may run out of memory on large scale systems
On large scale systems, with large numbers (1000+) of managed nodes and/or large numbers
(1000+) of logical servers on a 64-bit CMS, the HP Logical Server Automation service may run
out of memory and display out of memory errors in the /logs/hp_lsa_service.log or /logs/
vselog.lsm.log file. You may see the following errors:
java.lang.OutOfMemoryError: GC overhead limit exceeded
java.lang.OutOfMemoryError: Java heap space
java.lang.OutOfMemoryError: PermGen space

Suggested action 1
To correct the GC overhead limit and/or Java heap space errors, modify the configuration file to
increase memory allocation, as follows.
1.
2.
3.

Modify the configuration file (shown in the default location) at C:\Program Files\HP\
Virtual Server Environment\conf\hp_lsa_service.conf.
Increase the value of wrapper.java.maxmemory=1024. HP suggests a value of 2048.
Restart the HP Logical Server Automation service.
Logical Server Management
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Suggested action 2
To correct the PermGen space error, modify the configuration file to increase permanent generation
size, as follows.
1.
2.

Modify the configuration file (shown in the default location) at C:\Program Files\HP\
Virtual Server Environment\conf\hp_lsa_service.conf.
Add the following line. (Change additional.2 to additional.3 if a line with
additional.2 already exists; change additional.2 to additional.4 if lines with
additional.2 and additional.3 already exist, and so on.)
wrapper.java.additional.2=-XX:PermSize=32m -XX:MaxPermSize=128m

3.

Restart the HP Logical Server Automation service.

Unmask catalog-based storage volumes before removing storage volumes
For a SAN Catalog Storage Entry and a SAN Pre-populated Catalog Storage Entry, the Remove
Volume action on the Add/Modify Storage Pool Entry screen returns the selected storage volume
to the storage catalog as an available resource. However, the Remove Volume action does not
change the presentation of the storage volume. If masked, the storage volume remains presented
to the WWN assigned to the storage pool entry. This state can lead to unexpected errors. For
example, if the Administrator attempts to add a new storage volume to the storage pool entry, the
presentation may fail because the requested logical unit number is already in use.
In Insight Dynamics 6.2, if you attempt to remove a storage pool entry from a logical server, a text
box is displayed that reminds you to unmask the storage volume before removing it. To proceed
with the remove volume operation, delete the string “Type YES to proceed with this operation:”,
type YES and click OK to continue.
Suggested action
Unmask the storage volume before removing the volume.
1.
2.
3.

4.
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If the storage volume is assigned to a logical server, quiesce all I/O operations to the disk
before performing the unmask operation.
For non-boot volumes, uncheck the Masked checkbox on the Add/Modify Storage Pool Entry
screen, then press Save.
For boot volumes, use HP Storage Provisioning Manager to change the presentation state of
the storage volume. From the SPM Volume Services screen, click the Goal associated with the
storage volume to be unmasked. On the Service Request Goal screen, click the Properties
button. Select the Properties constraint on the Goal Properties window and press Edit Value.
Uncheck the Presented: checkbox and press OK to close the Edit Value window and OK to
close the Goal Properties window.
For both non-boot and boot volumes, from the Add/Modify Storage Pool Entry screen, press
Remove Volume and press Save.

Issues and suggested actions

NOTE: The Masked checkbox associated with a storage volume in a storage pool entry is disabled
if the storage pool entry is marked Inoperable. In most cases, the inoperable state is irreversible.
However, if a storage pool entry is inoperable solely because SPM automation is disabled for one
or more of the assigned storage volumes, the state of the storage pool entry can be changed to
Operable by enabling automation for each of the assigned storage volumes. Check the Enable
fulfillment and automation (Active) box for each storage volume on the SPM Volume Properties
screen. After enabling automation for each of the volumes in SPM, click the Get/Refresh Pool
Entries button on the Manage Storage Pool screen to refresh the storage pool entry definitions.

Minor issues
Performing operations on logical servers outside of Virtualization Manager may cause
incorrect information to be displayed
If you use tools other than Virtualization Manager to manage logical servers, modifications to the
underlying resources managed by logical server management are not immediately reflected in the
logical server.
For example, if you modify the power state of a managed resource outside of logical server
management, the power state of the logical server is displayed incorrectly until logical server
management resets its data.
Suggested action
Wait several minutes for the logical server to reset its data, or use Tools→Logical Servers→Refresh...
to manually refresh server resources.

Imported logical server may not contain all storage pool entries after backup and restore
After a backup and restore operation, if you import an unmanaged Virtual Connect logical server
that contains a predefined storage pool entry, and the logical server was modified to add a storage
entry using the same fabric, the imported logical server may be missing the WWN from the added
storage entry.
Suggested action
Refresh logical server resources using the Tools→Logical Servers→Refresh... menu selection, and
selecting Virtual Connect Enterprise Manager. This corrects the logical server by adding a new
storage pool entry with the missing WWN to the logical server.

Storage validation of multiple volumes returns incorrect results
If more than one volume is defined for a storage pool entry, validating the storage definition may
not return correct results. The information returned for one volume (actual storage size, RAID level,
and host mode) is displayed for all volumes.
Suggested action
Validate each storage volume separately. Enter volume and path information for one storage
volume, validate it, and delete it. Repeat for each volume in the storage pool entry, then add all
of the volumes back and save the entry.

Catalog storage pool entries with redundant paths that use XP storage array volumes
complete presentation with errors
If you attempt to create a catalog (SPM) storage pool entry that uses an XP storage array volume,
and you select the redundancy checkbox in the Volume and Path Selection table, after saving the
entry the presentation status of the storage pool entry will be “Completed with Errors.” This occurs
because the same Storage Port WWN is incorrectly used for both the primary and secondary path
for each volume.
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Suggested action
Do not specify redundant paths for XP storage array volumes.

Data disk may not be presented at the end of provisioning when SAN Catalog Storage
Entry is specified
If you include the data volume and the boot volume in the same Storage Pool Entry when specifying
a SAN Catalog Storage Entry, the data volume may not be presented at the end of provisioning
using Insight Orchestration. When you view the Storage Pool Entry, the data volume is unmasked
(the Masked checkbox is unchecked).
Suggested action
Manually check the “Masked” checkbox for the data volume on the Storage Pool Entry screen.

mxsync fails with “Synchronization module com.hp.vse.lsa.mxsync.LsaMxsyncFactory is
not found” error
If Insight Dynamics is installed to a directory other than the default directory, mxsync will fail to
load the “Logical servers and associated SAN-based storage” module and exit with the error
“Synchronization module com.hp.vse.lsa.mxsync.LsaMxsyncFactory is not found.”
Suggested action
Modify the value of JarDirectory in the file <System Insight Manager Installation
Directory>\mxsync\mxsync\conf\module\lsm.xml to correctly point to the directory
containing the lsa-mxsync.jar file, <Insight Dynamics Installation Directory>/
lib/lsa.

Viewing or editing the logical server management properties file may cause failure of the
LSA service
Viewing or editing the lsa.properties file may write lock the file while the HP Logical Server
Automation service is running. This may cause a serious failure of the service.
Suggested action
Use a text editor that does not lock the file, such as Emacs, Notepad, or TextPad.

Error when manually restarting LSA service
If you manually restart the Logical Server Automation service, the error “Could not start the Logical
Server Automation service on Local Computer. The service did not respond to the start or control
request in a timely fashion.” is displayed.
Suggested action
You can safely ignore this error. The service will restart after a short delay.

Process Resource Manager
Limitations
Creating and modifying configuration files with privilege elevation enabled is not supported
If privilege elevation is enabled in Systems Insight Manager, you can monitor Process Resource
Manager (PRM), but you may experience problems performing PRM operations. Specifically,
creating and modifying PRM configuration files may report success even though the operations
hang.
Suggested action
Do not change PRM configuration files using the PRM user interface when privilege elevation is
enabled.
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Virtualization Manager
Major issues
Selecting the Workload tab or Profile Viewer after a logical server activation may cause an error
or null pointer exception
In rare instances after activation of an HP Integrity VM logical server, if you select the Workload
tab or the Profile Viewer, the following error may be displayed: “The selected workload was not
found," or it may result in a null pointer exception.
Suggested action 1
Wait for the problem to resolve itself, which may take several hours or up to 24 hours.
Suggested action
Restart Systems Insight Manager to correct the problem immediately.
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4 Support and other resources
Contacting HP
Information to collect before contacting HP
Be sure to have the following information available before you call contact HP:
•

Software product name

•

Hardware product model number

•

Operating system type and version

•

Applicable error message

•

Third-party hardware or software

•

Technical support registration number (if applicable)

How to contact HP technical support
Use the following methods to contact HP technical support:
•

In the United States, see the Customer Service / Contact HP United States website for contact
options:
http://welcome.hp.com/country/us/en/contact_us.html

•

In the United States, call 1-800-HP-INVENT (1-800-474-6836) to contact HP by telephone.
This service is available 24 hours a day, 7 days a week. For continuous quality improvement,
calls might be recorded or monitored.

•

In other locations, see the Contact HP Worldwide website for contact options:
http://welcome.hp.com/country/us/en/wwcontact.html

Registering for software technical support and update service
HP Insight Software products include one year of 24 x 7 HP Software Technical Support and
Update Service. This service provides access to HP technical resources for assistance in resolving
software implementation or operations problems.
The service also provides access to software updates and reference manuals, either in electronic
form or on physical media as they are made available from HP. Customers who purchase an
electronic license are eligible for electronic updates only.
With this service, HP Insight Software customers benefit from expedited problem resolution as well
as proactive notification and delivery of software updates. For more information about this service,
see the following website:
http://www.hp.com/services/insight
There are two methods for registering:
•

If you received a license entitlement certificate, automated registration for this service takes
place upon online redemption of the license certificate/key.

•

If the license information you received for your product instructs you to register for Software
Technical Support and Update Service, you must follow the instructions in order to be eligible
for telephone support and product updates.
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How to use your software technical support and update service

After you have registered, you will receive a service contract in the mail containing the Customer
Service phone number and your Service Agreement Identifier (SAID). You need your SAID when
you call for technical support. Using your SAID, you can also go to the Software Update Manager
(SUM) web page to view your contract online and elect electronic delivery for product updates.
Warranty information

HP will replace defective delivery media for a period of 90 days from the date of purchase. This
warranty applies to all HP Insight Software, HP Systems Insight Manager, and ProLiant Essentials
products.
HP worldwide customer service contact numbers

HP worldwide customer service contact numbers are available at the following website:
http://welcome.hp.com/country/us/en/wwcontact_us.html

Security bulletin and alert policy for non-HP owned software components
Open source software (such as OpenSSL) or third-party software (such as Java) are sometimes
included in HP products. HP discloses that the non-HP owned software components listed in the
HP Insight Dynamics end user license agreement (EULA) are included with HP Insight Dynamics.
To view the EULA, use a text editor to open the /opt/vse/src/README file on an HP-UX CMS,
or the <installation-directory>\src\README file on a Windows CMS. (The default
installation directory on a Windows CMS is C:\Program Files\HP\Virtual Server
Environment, but this directory can be changed at installation time.)
HP addresses security bulletins for the software components listed in the EULA with the same level
of support afforded HP products.
HP is committed to reducing security defects and helping you mitigate the risks associated with
security defects when they do occur. HP has a well defined process when a security defect is found
that culminates with the publication of a security bulletin. The security bulletin provides you with a
high level description of the problem and explains how to mitigate the security defect.

Subscribing to security bulletins
To receive security information (bulletins and alerts) from HP:
1. Open a browser to the HP home page:
http://www.hp.com
2.
3.
4.
5.
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Click the Support & Drivers tab.
Click Sign up: driver, support, & security alerts, which appears under Additional Resources
in the right navigation pane.
Select Business & IT Professionals to open the Subscriber's Choice web page.
Do one of the following:
•

Sign in if you are a registered customer.

•

Enter your e-mail address to sign-up now. Then, select the box next to Driver and Support
alerts and click Continue.

Support and other resources

HP authorized resellers
For the name of the nearest HP authorized reseller, see the following sources:
•

In the United States, see the HP U.S. service locator website at:
http://www.hp.com/service_locator

•

In other locations, see the Contact HP worldwide website at:
http://welcome.hp.com/country/us/en/wwcontact.html

Documentation feedback
HP welcomes your feedback. To make comments and suggestions about product documentation,
send a message to:
docsfeedback@hp.com
Include the document title and manufacturing part number in your message. All submissions become
the property of HP.

Related information
The latest versions of manuals and white papers for HP Insight Dynamics and related products can
be downloaded from the HP Web. Documents for HP Insight Dynamics software can be found at
http://www.hp.com/go/insightdynamics/docs.
For more information about HP Insight Dynamics and related products and solutions, visit the
following HP website:
•

HP Insight Software: www.hp.com/go/insightsoftware

•

HP Insight Dynamics: www.hp.com/go/insightdynamics

Related information
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